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IN TRUE NEW YEARS’ SPIRIT, our team decided 
on resolutions as our theme. We asked ourselves the 
best way to share these with the members of WILL. In 
developing my own resolutions, I default to the classics, 
like spending more time with family and friends, making 
a commitment to my personal development, and getting 
in shape. And, like most of my friends, come February 
1, I wonder to myself, “How did I get so off track on 
my resolutions already?” This issue provides some 
great ideas for things we can implement not only in our 
professional lives, but that may enhance our personal 
ones as well. 

The Winter 2023 WILLed Magazine entitled, “Technology 
Resolutions - Tips, Tricks & Troubles,” contains articles 
from writers throughout the industry providing ways for 
us to harness and gain an advantage from many of the 
technological tools available today. In addition, there 
are pieces focusing on the potential advantages of 
using technology for functionality and compliance, for 
representing clients and even for helping others. And, 
while we look at the lighter side of technological boo-
boo’s, we also examine the darker side of Cybersecurity.

On the use of technology for connecting with 
others, Kathleen Kramer and Pat Mangan provide a 
comprehensive look at using “TikTok for Communication 
& Education.” Rosalie Escobedo guides us on “LinkedIn 
Tips ‘n Tricks” to improve and increase your connections. 
Jeffrey Schoenberger provides advice for Microsoft Word 
in “Where There’s a WILL there’s a Word.” 

On the fun and personal side, Annalise Deluca highlights 
what can happen “When Technology Goes Wrong.” 
In our What’s Your Passion? category, as a new 
contributing writer, Shylah Maloney shares “Finding 
Strength while Helping Others.” Jan Duke provides 
issues to consider when “Remotely Connecting with 
Your Team / Clients / Vendors.” Julia Keys guides us with 
great insight on “How to Unplug and Maintain Work-Life 
Balance.”

Michelle Gilbert presents advice from personal 
experience and highlights court rules in “Protocol for 
Virtual Hearings.” “Integration Ideas to Implement: Make 
Mailing Easier with a Virtual Mailroom” from Holly Baya 
illustrates factors to consider when integrating your 

mailroom. Harrison Tropp and I share “A Resolution for 
Cybersecurity Safety,” highlighting ways to reduce and 
mitigate the risk of attacks. And lastly, Kathleen Kramer 
and I are back with another edition of “Getting to Know 
You,” focusing on the ALFN leadership teams of Amicus 
Briefs and Bankruptcy.

Take your time, while keeping in mind your work-life 
balance, to peruse the articles contained in this edition. 
Download the electronic version so, in the future, you can 
refer to the great tips provided on LinkedIn, Word, and 
TikTok. Attend virtual meetings and hearings safely, all 
while adhering to the advice on Cybersecurity. Thanks 
to all the contributors in each edition who make this 
publication a great source of advice.

Good luck with your personal and professional 
resolutions! I’m looking forward to seeing you at future 
ALFN events. 

Letter from 
the Editor

MICHELE LUBLIN
Director of Operations
Rubin Lublin, LLC
mlublin@rlselaw.com
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MAKE MAILING EASIER  
WITH A VIRTUAL MAILROOM

BY HOLLY BAYA

BUSINESS DEVELOPMENT DIRECTOR

IMAILTRACKING

HOLLY.BAYA@IMAILTRACKING.COM
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I T  IS  A  R ARE OC CURRENCE WHEN I  CHEC K MY MA I L  AND 
F IND SOME THING BES IDES JUNK .  MOST OF MY B I LLS ARE 
PAPERLESS,  AND I  STAY IN  TOUCH WITH D ISTANT FR IENDS 
AND FAM I LY V IA  PHONE ,  TE X T,  EMAI L ,  OR SOC IAL MEDIA . 
SOC IE T Y HAS MOVED AWAY FROM MAI L ,  AS THE BEDROC K 
OF THE U.S .  POSTAL SERV ICE IS  CRUMBL ING . 

ALFN WILLed // VOL. 8 ISSUE 1 8



The world is changing daily, for better or worse, and 
it seems there is an easy digital way to do everything. 
Firms are taking advantage of these myriad new ways to 
reduce paper and labor, to save time and money. Then, 
everything comes screeching to a halt because someone 
must physically mail something. Or does it? 

Mail isn’t glamorous, but it is necessary in our in-
dustry. Luckily, you have options which will allow you 
to embrace the new digital landscape while remaining 
compliant with the aged rules and regulations surround-
ing physical mailing. Mail outsourcing service providers 
offer firms the ability to utilize a virtual mail room. 

REASONS TO CONSIDER A  
VIRTUAL MAILROOM:

• No need to buy and maintain equipment, supplies or 
provide storage space

• No need to maintain expensive leases

• Ability to provide detailed back up of mailing expens-
es to ensure maximum reimbursement

• Access to reporting capabilities related to your mailing 

• Reduce or eliminate the need to hire, train and retain 
mail room staff

• Reduce labor spent printing letters, stuffing envelopes 
and trips to the mailroom

• Ability to manage large, unexpected or intermittent 
mailing projects for your firm or your clients

• Return or inbound mail management

Mail is a necessary component of many of our day-to-
day lives, but it is often under-considered, because it 
is background noise. It has just been there, for years 
and years, unchanged, a monolith, an uncomfortable 
necessity. 

Mail outsourcing vendors offer a variety of integra-
tion options and usually a web ordering option. Mailing 
vendors work with firms that send a few pieces of mail 
quarterly to those who mail thousands of items a month. 
Even if you do not process a lot of mail, you may still be 
a perfect candidate for mailroom outsource. Why spend 
time and resources building processes around some-
thing you do not do often? 

Compliance is critical and using a mail vendor can 
assist with proving that compliance. The vendor you 
select should have positive feedback from auditors 
whose jobs are made easier by the clean records that 
will be provided. Instead of dropping a mail piece into 
a bin internally, you have a complete digital record of 
that mailing. That digital record includes all the post-
al numbers, recipient information, an image of what 
was mailed, and a breakdown of fees and costs. These 
records can move into your case management system 
or be accessed through a web portal. Return mail, in-
cluding return receipts, and even inbound mail could 
be managed through the service. 

Outsourcing any function can be a scary proposition, 
but there are things outsourced these days that would 
have been unthinkable or impossible a few decades ago. 
Give some thought to your unique process and how a 
mailing vendor could potentially assist.

For those of you who are using a mail outsourcing 
vendor, please share your experiences with your col-
leagues. Word of mouth is powerful, persuasive, and 
can assist anyone facing the same challenges. 

COMPLIANCE IS CRITICAL AND USING  
A MAIL VENDOR CAN ASSIST WITH  

PROVING THAT COMPLIANCE .

ALFN WILLed // VOL. 8 ISSUE 1 9



A RESOLUTION FOR 
CYBERSECURITY SAFETY
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BY MICHELE LUBLIN
DIRECTOR OF FINANCE & OPERATIONS
RUBIN LUBLIN, LLC
MLUBLIN@RLSELAW.COM

HARRISON TROPP
PARTNER
SHEA BARCLAY GROUP
HARRISON@SHEABARCLAY.COM

CLOSE TO 40 YEARS AGO IN 1983,  
War Games was released in theaters. It was a smash hit, 
grossing $125 million worldwide. For those who may not recall, 
the movie, starring Matthew Broderick, focuses on a high school 
whiz kid who connects to a military supercomputer and almost 
launches a global thermonuclear war. At the time, in grade 
school and high school, we could not fathom why anyone would 
spend a significant amount of time trying to get into someone 
else’s computer. Why bother? Fast forward to May 2021, and a 
ransomware attack on Colonial Pipeline brought down a major 
pipeline for several days, causing massive gasoline disruptions 
across the Eastern portion of the United States. It became clear 
why someone would bother – for the money.

This article highlights the major types of cybersecurity threats, insurance coverage options, 
what to do in the event of a claim, both the hard and soft costs of an attack, and the steps 
you and your organization should take to reduce the risks. There are several hundred arti-
cles published on the topic annually, and each highlight what it believes to be the biggest 
threat today. Most concur on the primary four methods of attack: Malware, Ransomware, 
Social Engineering, and Phishing.
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M A L W A R E :
Defined as ‘any malicious form of 
software designed to harm a comput-
er system.’1 This malware can steal, 
delete, or encrypt data, or track users’ 
actions and may include worms, vi-
ruses, Trojan horses, and spyware. ‘Ac-
cording to Norton Security… in 2023, 
it is estimated cybercriminals will be 
stealing 33 billion records per year.’1 

R A N S O M W A R E :
Works by infecting your network and 
encrypting your data and locking 
down computer systems until a ran-
som is paid to the hacker.2 According 
to Titan File, Ransomware is one of 
the biggest security threats in 2022.

S O C I A L  E N G I N E E R I N G :
Attacks ‘rely on human or social inter-
action, not just bots entering a com-
puter through the internet.’1 Social en-
gineering attacks also attempt to focus 
on the recipient’s emotions by project-
ing a sense of urgency or distress.

P H I S H I N G :
One of the most commonly used 
forms of Social Engineering, ‘occurs 
when a hacker uses a false identity to 
trick someone into providing sensitive 
information, downloading malware, 
or visiting a site containing malware.’1 
One example is when a phisher sends 
an email pretending to be the boss and 
asks the recipient to buy a bunch of 
gift cards on their behalf. The second 
part of this scheme is to request the 
numbers and codes be sent directly to 
them off the cards.

In a time where rising compliance 
costs continue to affect a firm’s bot-
tom line, the last thing firms wish to 

consider is an additional insurance 
premium. While cyber liability poli-
cies are often a requirement of client 
services agreements, they are also a 
prudent and highly recommended 
option. That said, we constantly field 
questions from clients and colleagues 
alike asking, what does a cyber insur-
ance policy actually cover? The answer 
is probably just as complex as the pol-
icy itself. While the policy language is 
quite thorough, it can be highly mis-
interpreted. For example, a firm may 
have a main limit of coverage, let’s say 
$3,000,000, but they fall victim to a 
social engineering attack which caps 
coverage at $250,000. Another ex-
ample is if a $500,000 wire is sent in 
error, the most the policy will pay for 
that direct loss is $250,000. Although 
the limit for the direct loss has been 
used, a firm may use other sub-limits 
of coverage (e.g., betterment, loss of 
income, hardware expenses, etc.) up to 
the full policy limit. 

Not only has the War Games plot 
become more and more realistic, but 
the thought of a law firm also encoun-
tering a data breach has increased 
substantially over the last several 
years. Whereas cyber incidents have 
become more common among large 
multi-national firms, hackers are now 
targeting smaller firms who may have 
less sophisticated preventative con-
trols. As the adage goes, it’s no longer 
“if” but “when.” We want to especially 
note that default firms have really set 
the standard given the stringent com-
pliance requirements, including GSE 
directives, they must follow. That’s 
not to say these types of firms won’t 
encounter a breach; however, the loss 
can be much less severe. 
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What if you are the managing partner of your law 
firm and have just been notified that there has been a 
data breach: what now? In the event of a breach, there 
are certain steps which must be followed to ensure any 
loss or potential loss is mitigated, and more important-
ly, covered by the carrier. At the risk of sounding obvi-
ous, sometimes the most important step is the most ba-
sic. If payment was made to a bad actor either through 
a wire transfer, check, or some other form of payment, 
it’s imperative a stop payment be issued immediately. If 
a data breach did occur, a firm’s IT department would 
be in the best position to try and immediately contain 
the breach.

This next step may also be incredibly apparent, 
however it’s the one least followed. Once an insured 
realizes they have been the victim of a cyber-attack, the 
insurance carrier must be immediately notified. Prompt 
reporting to the carrier will ensure the claim or poten-
tial claim is covered. The quicker communication is 
relayed, the sooner the incident can be resolved. Time 
is of the essence. The cyber insurance policy is there to 
respond in the event of a data breach or cyber loss. It 
will ultimately fall to the carrier to coordinate an inci-
dent response team, usually consisting of data security, 
restoration, and legal experts. The better prepared a 
firm is to not only prevent a breach, but to remediate 
one as well, will make all the difference. 

What can you and your organization do to reduce 
the risk? Notice how we did not say, prevent. As men-
tioned before, at one point or another, a bad agent is 
going to attempt to infiltrate your IT systems, and may 
even succeed, but each organization can take steps to 
limit the risk and ensure you have the resources in 
place to deal with it when it happens. Here are some 
suggestions, although there are plenty more which can 
be implemented. The most important method to com-
bat social engineering and phishing attacks, as well as 
ransomware, is a regular, well-defined, and implement-
ed ongoing cybersecurity awareness training program 
for employees. This includes everyone from your lowest 
level staff worker to your CEO, Managing Partner and 
other key members of the C-Suite. 

In addition to having a vigilant training program, 
an all-inclusive technological support base, a well-de-
signed insurance program, and a quick and compre-
hensive response to a possible and/or verified attack, 

here are some specific steps you can take to reduce the 
risks to your organization of a cybersecurity attack.

 ;Don’t allow users to share company usernames or 
passwords electronically. Have them call each other 
if they have no other option other than to share 
them.

 ;Alert users of emails which originated outside your 
network by adding a banner to the top of any email 
received from an external source.

 ;Segment your network, perform frequent backups 
and develop a strong incident response process. 
Have a very strong firewall which constantly re-
viewed and updated rules.

 ;Use antivirus software, as well as keep all software 
updated.3

 ;Perform frequent patch management and use auto-
mated tools to scan for outdated applications and 
missing patches.1 

 ;Enable Muti-Factor Authentication (MFA) and have 
employees use a standard password manager to 
keep track of all their passwords.

 ;Ensure your WIFI network has a strong password 
which is changed frequently (at least every 90 
days).

 ;Confirm all remote employees use a Virtual Private 
Network (VPN) to allow them to connect to your 
network securely.

 ;Control physical access to all technology on-
site and ensure mobile devices, like laptops and 
phones, use required passwords. In addition, do 
not allow the use of unmonitored USB drives on 
any device. 

1Straight Edge Technology, ‘8 Top Cybersecurity Threats for Businesses in 2022 [& 
How to Prevent Them]’, https://straightedgetech.com/5-top-cybersecurity-threats-
and-their-solutions-for-2020/ 

2Titan File, ‘Top 10 Cybersecurity Threats of 2022’, https://www.titanfile.com/blog/
top-10-cybersecurity-threats-of-2022/ 

3U.S. Small Business Administration, ‘Strengthen your cybersecurity’, https://www.
sba.gov/business-guide/manage-your-business/strengthen-your-cybersecurity
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WHEN 
TECHNOLOGY 
GOES BAD 
Tech Blunders of the Virtual Era

BY ANNAL ISE HAYES DELUCA
PARTNER
MC M ICHAEL TAYLOR GR AY, LLC
ADELUCA@ MTGL AW.COM
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“I AM NOT A CAT” 
the now infamous line from the Zoom hearing shared ‘round the world. We’ve 
all had it happen, that moment while using technology when something goes 
terribly wrong. That’s exactly what happened to attorney, Rod Ponton, during a 
hearing in May 2021. At the beginning of the hearing, the Judge informed Mr. 
Ponton that he appeared to have a filter on his Zoom and asked him to remove 
it. Unfortunately for Mr. Ponton, but fortunately for the rest of us who have now 
seen the video, he was unable to figure out how to turn the filter off. The result 
was an entertaining video of a man’s voice coming from a distressed, wide-eyed 
cat. There were many technology gaffes during the pandemic, but a talking cat 
practicing law might just top the list. 

Technology appears to be the great equalizer. It’s 
not just the attorneys who have had technological 
mishaps as we have all made the transition to vir-
tual hearings. In one of my own hearings, the Judge 
appeared several minutes late to a hearing. When 
he did appear, he was upside down with an aquari-
um full of aquatic life in the background. 
He was understandably f lustered. What 
should have been a quick five-minute sta-
tus hearing, turned into a 20-minute de-
bacle with the Judge trying to figure out 
how to turn himself right-side up and turn 
off those “darn fish.” Consider him another 
victim of an unintended Zoom filter. 

While Zoom filters and settings can be tricky to nav-
igate, it’s what the people behind the screen are wearing 
(or not) that often leads to epic bloopers. Everyone has 
rocked it – the professional on top, party on the bottom 
uniform of the pandemic. If we asked people at random 
to stand up during a video call, I’m sure we would find 
an array of sweatpants, shorts, and other less-than- 
professional attire. That’s assuming people are wearing 
anything at all. Various videos from all over the inter-
net show what happens when people inadvertently give 
a look at their head-to-toe look. From the teacher who 
blamed his students seeing his blue boxer shorts on a 
“glitch” to the guy who got up to scratch his pants-less 
bottom after he thought the video meeting had ended – 

one needs to always make sure the camera is focused on 
the waist up. 

Other major technology fails in the virtual era include: 
embarrassing search histories and websites on display 
during screen-share, forgetting to press mute before 
arguing with your significant other or using the bath-

room, and surprised naked spouses in the background 
of video meetings. While some technology fiascoes can-
not be avoided, we can all do our best to minimize the 
risk. Before getting on video, preview your settings to 
ensure they haven’t been altered since the last time you 
used the application. Make sure you preview what your 
screen will look like to others before entering a group 
setting because the camera may catch more than you 
anticipate. Clear out all websites, background applica-
tions, and search history before screen-sharing. And for 
all of our sakes, make sure you are muted if you aren’t 
the one speaking. With a little extra effort, may we all 
avoid those embarrassing moments where technology 
turns from friend to foe. 

And for all of our sakes, 
make sure you are muted if 
you aren’t the one speaking.
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HOW TO

UNPLUG
AND 

MAINTAIN  
WORK-LIFE BALANCE
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BY JULIA KEYS
DIRECTOR OF CLIENT SERVICES
ORLANS PC
JKEYS@ORLANS.COM 
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The term work-life balance, sometimes called work-life 
integration or work-life harmony, refers to how people 
prioritize responsibilities at their jobs and in their per-
sonal lives. This includes not only how they integrate 
those two worlds, but how much time they have for per-
sonal matters apart from work. 

Let us explore what exactly we need to unplug from to 
feel refreshed, revived and to recharge our internal bat-
teries so we can offer the very best versions of ourselves 
to our careers, families, and friends. Creating bound-
aries and time limits around our job commitments sets 
the tone and pace for equitable balance to ensure we 
do not reach a point of burnout mode. This also allows 
our physical and mental beings to remain fully present 
during our most important interactions following work 
commitments. Tuning into the people and hobbies that 
matter to us in life once our workday has ended and tun-
ing out of electronics is one of the most effective ways to 
accomplish this.

WHY IS UNPLUGGING SO IMPORTANT? 

• To maintain optimal physical/mental health and 
well-being: Multiple studies over decades of time 
indicate that the stress hormones released into the 
body from burnout mode due to lack of sleep, work-
life balance, and overstimulation over long periods 
of time are harmful to our physical health and emo-
tional well-being.

• To maintain healthy family and work/life relation-
ships: You have heard the saying, “too much of any-
thing is not good for you.” This could not be a truer 
statement. When we are not at our best due to opti-
mal balance of work and personal time, we are nat-
urally prone to exhibit frustration, resentment and 
unhappiness in our actions and behaviors. Whom 
shall we presume feels the brunt of this the most? 
You guessed it; those to whom we are closest, our 
family and friends.

THE INTENDED purpose of 
the phrase “Work-Life Balance” and its level of 
importance seems to be inherently understood 
and recognized by much of the workforce in 
America today. That said, the lingering question 
of how to accomplish this continues to plague 
many among workers and business owners alike. 
Do most Americans practice this in their everyday 
lives? Are businesses promoting the importance of 
“unplugging” while supporting this idea as a mental 
health awareness initiative with their staff? Is the 
workforce inherently aware of how to unplug and 
maintain work-life balance? Or is this still merely 
seen as a tabu subject by many organizations?
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• To increase productivity and focus: A 2018 study 
from Sanford showed productivity decreases when 
you work over 50 hours per week. In fact, compa-
nies that offer 32-hour workweeks or six-hour work-
days report both an increase in productivity and 
higher employee satisfaction. Maintaining work-life 
balance maximizes your productivity optimizing 
your contributions and ability to focus on giving 
your absolute best to tasks and employees who may 
rely on you. 

One of the many reasons unplugging is so difficult, is 
quite simply the psychological phenomenon referred 
to as “anticipatory stress,” which means, the anxiety 
we feel worrying about something that is coming or 

could come at any moment. In fact, according to a re-
cent LinkedIn survey, 70% of professionals admit that 
when they go on vacation, they do not fully take a 
break from work. 

Have you ever wondered why you did not feel re-
freshed after taking time away from work? Have you 
ever felt like you needed more time or just did not feel 
as though you had time off at all? With today’s handheld 
and wearable devices, AI, and the cloud, the boundaries 
which once existed between work and personal time no 
longer have a clear clock-out time anymore. They are 
merely blurred together. That said, technology is not 
solely to blame for our difficulties in developing healthy 
unplugging habits. Many times, the true pressure comes 
from a work culture which does not encourage personal 

“I’ve learned that you cannot HAVE everything and 
DO everything all at the same time.” 

— Oprah Winfrey 
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time or reward those who take time off. The many 
technological enhancements may provide us with the 
opportunities to do more in less time; however, our 
expectations for what we can “realistically” get com-
pleted in a single workday continues to outpace our 
output as the bar continues to be raised. All of this 
leaves us feeling constantly stressed and running be-
hind, with fear and anxiety something may be missed.

Many of our beliefs about work can be traced 
back to the industrial revolution and the birth of the 
40-hour workweek, which only appears to have in-
creased over time, connected to the more successful 
ladder you wish to climb. That said, and for many, 
the previous twelve-hour days focused on work well 
into the night has hit a wall in America and likely in 
the world as we once knew it.

While there are many examples we could dive into 
regarding how our family life suffers when we are un-
balanced with work and personal time, we know for 
a fact that our spouses and children are totally and 
completely one hundred percent aware when we are 
not unplugged. Family always picks up on our present 
nature or lack thereof. I know I have some witnesses 
reading this article that can attest to a spouse or part-
ner at some point becoming frustrated, annoyed, or 
genuinely hurt when they can sense they do not have 
your full attention. Am I right?!? This may happen 
during dinner while the unplugged partner is habitu-
ally checking their email or engaging with themselves 
on a continual rant about a work scenario, debacle or 
deadline that has them worked up for the rest of the 
night. If conversations typically always gravitate to-
wards work, ask yourself if your spouse et al. truly 
feels as though they are spending quality time with 
you and how that may affect the rest of the evening or 
may even lead into tomorrow. 

Children also sense our work-life stress, anxiety, 

“You can’t truly be considered successful in your 
business life if your home life is in shambles”.

— Zig Ziglar
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and inability to disconnect. After their day at school, most 
children look forward to coming home to spend time with 
their family. As children do not possess the same mental and 
emotional maturity level as adults and cannot always com-
municate their feelings, they tend to exhibit patterns of be-
havior in an effort to seek the attention they may be missing 
at home while we are busy looking at our emails or engaged 
in work during time that should be dedicated to them.

We all collectively recognize the need for unplugging. Let us 
know explore ways in which we can accomplish this.

• For starters, when it is time to unplug, place your phone 
on “do not disturb” so you are not easily distracted by 
notifications, phone calls, or emails.

• You can flag emails that are not emergencies to prioritize 
them to be read the next day.

• If you are headed out for vacation, establish parameters 
and boundaries at work coupled with a plan of a desig-
nated resource who will step in for you in your absence: 
Make it clear that unless the sky is falling, your time 
away should not be interrupted.

• Carve out concentration time by blocking off time 
on your calendar so you are “unavailable” for calls or 
meetings.

• Use a timer for a task you are working on. Once the tim-
er goes off, disconnect! 

• Engage in analog activity like:

 » Set up technology free zones in your home where hu-
man connection is unavoidable.

 » Create a home library and keep a favorite read nearby.

 » Take a digital diet and complete social media detox. 

 » Create instead of consuming!

 » Spend time in nature and/or with pets.

• Leave the phone at home, read a book, take an exercise 

“You will never truly 
feel satisfied by 

work until you are 
satisfied by life.”

—Heather Schuck
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class or gym visit and ditch the electronics while 
you are disconnecting.

• Maximize your time in the office, plan ahead, create 
to-dos and schedules. Stick to them!

• Meditate.

• If you are spiritually minded, spend quality time in 
this space and relate your beliefs to your commit-
ments in both your work and personal lives daily.

Studies found that employees, including executive 
management, are more productive when they main-
tain work-life balance and have carve-outs for their 
family, hobbies, and hard stops on maintaining a 
structured routine of knowing when to shut down 
for the day. One of the most important “light bulb” 
moments we will ever encounter is realizing that we 
are enough!

Attention Business Leaders: truly unplugging from 
work is a team effort. This must start and end at the 
top of organizations. As a leader, if you believe in this 
concept and wish to retain star and valuable talent, 

it is important to recognize we are in a pivotal shift 
of consciousness following the Covid 19 pandemic, 
and people have begun to recognize the value and 
importance of work-life balance. Stakeholders can put 
systems and tools in place to promote, encourage and 
respect their staff ’s time away. They need it, and they 
will return more productive than when they left and 
will value your investment in their personal well-be-
ing which builds trust and loyalty over the long-term. 
P.S. – Do not be afraid to be intentional because YOU 
need it too!

In closing, we should all ask ourselves, what does 
work/life balance mean to me? Am I walking the walk? 
What do I need to change for the betterment of my 
well-being, my work product, my family life, and my 
staff or team? We must all collectively understand this 
is not a request or like-to-have. Rather, this is a genu-
ine human need in society. Exercising respect for the 
importance of this concept amongst our colleagues and 
subordinates alike will avoid counterintuitive ways of 
thinking and create a permanent better work-life bal-
ance for all! 

It is now time for me to leave you with these thoughts 
and unplug! 

“Time is really the 
only capital that any 
human being has, 

and the only thing he 
can’t afford to lose.”
 — Thomas Edison
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LinkedIn
Tips and Tricks

BY ROSALIE ESCOBEDO
DIRECTOR OF BUSINESS DEVELOPMENT

MACKIE WOLF ZIENTZ MANN
RESCOBEDO@MWZMLAW.COM
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First things first, what does your LinkedIn header look like? Is it a 
Google image saved and uploaded? If so, replace the image with a 
customized header. Canva is a good tool for nearly everything related 
to social media. In the Canva app, search for ‘LinkedIn Header’ and 
add your name, title, and contact information. You will have to play 
with the formatting as it can appear different from creation to upload. 
I also suggest looking on both your laptop or computer and your 
phone, as adjustments may be needed to make the formatting look 
proper in both places. You can also create customized headers on 
Canva for Facebook, Facebook groups that you administer, and 
Twitter. Finally, make sure the font is big enough for contacts to be 
able to read and contact you. 

A professional headshot is a must for your Linke-
dIn profile pic. We all know that. However, did 
you know you can upload a LinkedIn video to 
your profile picture section? Go to your profile 
picture, click the lower plus sign, and upload 
or replace your current video. If you are selling 
services, do a quick elevator pitch here. If you’re 

looking for a job, articulate your great candidacy 
and desired position. You can also use the video 
to highlight philanthropy, conference, webinar, 
book, speaking engagements, or anything you 
want to emphasize. 

Keyword Optimization should be fully utilized. 
Under your name on your LinkedIn profile, be 

LET’S IMPROVE YOUR LINKEDIN PAGE!
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sure to fill out the section full of keywords 
that will make your profile findable by pros-
pects. The more keywords in this section 
and throughout your LinkedIn page, the 
better. 

The ‘About’ section should include your 
‘why.’ The length should be three or more 
paragraphs and tell the reader what you do 
in your career and the passion and purpose 
that propels and drives you. This should be 
written in first tense and evoke excitement 
about your career and life. It should not be 
identical to your current job description. 

The featured section is a great way to draw 
LinkedIn viewers to the posts, articles, and 
topics you want to highlight on your page. 
Add this by tapping your profile photo, then 
going to ‘view profile.’ From there, tap add 
profile section, tap recommended and select 

featured from the dropdown. Next, select 
the type of work you’d like to feature. The 
options are 1. add a post, 2. add a newsletter, 
3. add an article, 4. add a link, and 5. add 
media. My featured section includes getting 
to serve as the ALFN WILL Trustee-Chair, 
the Latinas in Power group, a recent we-
binar I was on, and a Women in Housing 
nomination, for example. 

Now, let’s talk subscribers. Growing your 
LinkedIn page or your company’s LinkedIn 
page is a slow and steady build. On your per-
sonal page, you can invite a set number of con-
tacts per week. Make sure to continue to grow 
your network. As an administrator, you can 
invite 250 contacts per month per page, and 
the invitations will pull from your personal 
page, which is why growing your subscriber-
ship on your personal page cannot be neglect-

A professional 
headshot is 
a must for 
your LinkedIn 
profile pic.
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ed. In 2022, we grew the MWZM LinkedIn page 
from 200 plus followers to 1500 plus followers 
by setting a reminder to invite the whole 250 po-
tential subscribers each month, and back-filling 
invites as we received declinations. 

LinkedIn posts should be varied and in-
teresting. Let the litmus test be whether you 
would want to read about it and whether 
the images and/or videos pull viewers into 
the content. Tagging organizations and con-
tacts can increase the reach of a post. Using 
hashtags will also increase the reach and 
breadth of the post. 

You can request recommendations from 
your industry colleagues. Make sure to pro-
vide well-thought-out and articulated recom-
mendations back to your colleagues. The key 
is making sure you have recent recommenda-
tion dates on your page. 

There is a name pronunciation tool avail-
able, especially if you have a difficult name. 
This tool is only available on your mobile 
phone. It can encourage people to contact you, 

who otherwise might be reluctant to call and 
accidentally butcher your name. To add this to 
your profile, on your phone, tap your profile 
picture, then ‘view profile’. Next, tap the ‘edit’ 
icon from your introduction section and tap 
add name pronunciation. The tool will record 
10 seconds of pronunciation. 

Creator mode is for influencers. You can 
turn your creator mode on. This allows Linke-
dIn to optimize you for publishing content. 
You allow people to follow you rather than 
only connecting. However, as people follow 
you, you’ll want to review their LinkedIn pro-
files and send connections to the profiles you 
scrutinize and deem to be good contacts. You 
cannot see the content of people that follow 
you and will have to connect with them to see 
their posts and content. 

Please allow this information to serve as a 
starting point for improving your LinkedIn 
page or your companies LinkedIn page(s). I 
hope you find these tips and tricks easy to im-
plement and serve you well. 
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Appearing in Court 
in Underwear

The Good, Bad and Ugly of Virtual Court Hearings
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CONTEXT
While the use of virtual technologies like 
telephone conferences, webinars, and 
zoom or WebEx meetings have been in ef-
fect for at least 25 years, fully virtual hear-
ings were almost nonexistent prior to the 
start of 2020. 1 When the COVID-19 out-
break caused courts worldwide to close in 
March 2020, many judicial systems turned 
to and sometimes mandated the use of vid-
eo and telephonic conferences to keep cas-
es moving, especially urgent matters like 
criminal and family law cases. This use of 
technology stemming from a pandemic led 
to ongoing review and critical analysis of 
the advantages and disadvantages of virtu-
al court hearings. 2

On March 27, 2020, President Don-

1  https://scholarship.law.wm.edu/cgi/viewcontent.cgi?article=1231&context=facpubs
2  https://www.americanbar.org/groups/judicial/publications/judges_journal/2021/summer/zoomed-to-justice-remote-proceed-

ings-during-pandemic/
3  Id at page 3.

ald Trump signed into law the CARES Act 
(Coronavirus Aid, Relief and Economic Se-
curity Act), which, in addition to providing 
over $2 trillion of economic relief, also pro-
vided about $7.5 million to the federal ju-
diciary to expand remote work and virtual 
court hearings, specifically to allow certain 
federal criminal and civil proceedings to 
be held virtually. Immediately, all thirteen 
federal courts of appeal began live stream-
ing of their oral arguments, and for the first 
time, the U.S. Supreme Court allowed audio 
broadcast of its May 2020 oral arguments, 
which were conducted over the telephone. 3

Though the CARES Act authorized 
video and telephonic hearings in certain 
cases, funding ends 30 days after the date 
on which the national emergency ends, 

BY MICHELLE GARCIA GILBERT
MANAGING PARTNER
GILBERT GARCIA GROUP, P.A.
MGILBERT@GILBERTGROUPLAW.COM 

ALFN WILLed // VOL. 8 ISSUE 1 29



which is now January 11, 2023, or when 
the Judicial Conference, the national pol-
icymaking body for the federal courts, 
finds that the federal courts are no longer 
materially affected. 4

WHAT’S WORKING WELL, AND 
NOT SO WELL
The pandemic enabled the legal industry 
and justice system to partake in more effi-
cient and effective proceedings, especially 
for shorter hearings and uncontested hear-
ings. Or for more complex proceedings, like 
depositions and evidentiary hearings, the 
ability to “remote in” saves time and money. 
And some trials, like family law and sim-
pler civil cases, and administrative hearings, 
lend themselves more to a virtual format. 
Also, participants have found that some 
highly complex cases with multiple parties, 
witnesses, and experts can be handled re-
motely without the need for physical court-
room space. 5

The criminal justice system is one area 
where virtual hearings do not work as well. 
Defendants may be incarcerated or unable 
to access technology or have poor technol-
ogy, which all may combine to inhibit a 
criminal defendant’s ability to communicate 
with an attorney, advocate for himself, and 
to confront witnesses as well as engage with 
witnesses and utilize physical evidence. The 
use of virtual breakout rooms and mute but-
tons helps, though misuse may occur.

In a Missouri courtroom, a defense attor-
ney claimed a judge muted him “eight times 
during a 48-minute hearing, including once 
for five minutes and another time for seven 
minutes.” The judge had allowed the pros-
ecutor to attend the hearing in person but 
required that defense counsel appear by 
videoconferencing. The judge stated that 

4  https://www.uscourts.gov/news/2020/03/31/judiciary-authorizes-videoaudio-access-during-covid-19-pandemic
5  https://news.bloomberglaw.com/us-law-week/virtual-courts-are-not-going-away
6  https://abovethelaw.com/2020/07/fun-with-mute-buttons-civil-rights-violation-edition/

the defense counsel was annoying and ob-
structionist. Query: How was the defendant 
affected, and would a totally in-person pro-
ceeding had a different result? 6

BEST PRACTICES
Virtual hearings are here to stay, with the di-
viding line being pre-2020 and post-COVID, 
and therefore the post-COVID part allowed 
participants to develop remote procedures 
which can be broken down as follows:
• remote procedures applicable to all 

proceedings,
• applicable to non-evidentiary 

proceedings,
• deposition procedures,
• mediations.

For all remote proceedings, the court 
should provide the link to the virtual plat-
form, and all notices of hearing should state 
that the proceeding will occur by video, as 
well as provide video conference details 
such as links and login information. All 
participants (including court reporters and 
other technical assistants) should present 
professionally, as though they were appear-
ing in person. Locations should be quiet 
and free from distractions, and not such as 
to create a public safety issue, such as while 
driving a car.

Participants should use a device that 
allows them to have access to a camera, 
speaker, and microphone, depending upon 
what type is needed, and a wired internet 
connection is preferred. Participants should 
display their name, know how to mute and 
unmute, and have video on, if applicable, 
during the proceeding and especially when 
speaking.

The court should provide for breakout 
rooms to allow attorneys to confer with cli-
ents. Finally, participants should act in good 
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faith to assist other participants who are having techni-
cal difficulties.

For non-evidentiary proceedings, in addition to the 
above, participants should check court procedures, and 
should email copies of any materials to be used to the 
court and opposing parties no later than 48 hours in 
advance. The court may allow participants to share case 
law, documents, photographs, or other materials via 
screen-sharing.

For evidentiary proceedings, in addition to all the 
above, the court may schedule a prehearing conference 

in advance of any evidentiary hearing to address the 
handling of sequestration of witnesses, document shar-
ing, and use of physical evidence.

At least seven calendar days in advance of an eviden-
tiary hearing, parties should exchange exhibit lists using 
Bates numbers, and should meet and confer within five 
calendar days in advance to stipulate on the admissibil-
ity of evidence. Parties should then jointly prepare an 
index of exhibits which should be sent to the clerk and 
court, following the judge’s preferences and procedures.

At least ten business days in advance, parties should 

The judge stated that the defense counsel  
was annoying and obstructionist.
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exchange witness lists and should ensure 
that witnesses have copies of evidence 
about which they will testify, as well as be 
informed about witness testimony protocol, 
including providing identification prior to 
testimony. If sequestered, witnesses should 
be placed into a virtual waiting room.

For deposition procedures, in addition to 
all the above, the court reporter may ad-
minister oath or affirmation remotely. The 
deponent can be required to show the envi-
ronment where the deponent is located and 
should not disable their cameras during 
the deposition. All participants can appear 
remotely unless the witness requests that 
witness’s counsel be present in the same 
physical location, and if in the same loca-
tion, they must use separate video camer-
as. Any documents that the witness will 
use should be provided as soon as possi-
ble as well as at the time of the deposition, 
and can be managed electronically, using 
screensharing technology.

The host of the deposition should only ad-
mit participants entitled to be present un-

7 See generally, https://www-media.floridabar.org/uploads/2022/08/TFB-Best-Practices-Guide-For-Remote-Court-Proceedings-2022-Edi-
tion.pdf.

8  https://www.floridabar.org/the-florida-bar-news/the-virtual-lawyer-a-lost-generation/

der the rules of court and should secure the 
deposition access with a password or simi-
lar security.

The deponent should not engage in any 
private communication, or turn off their mi-
crophone while on record, though deponent 
may confer with counsel during a break in 
a breakout room.

For mediations, in addition to all the 
above, all confidentiality protections apply. 
All parties should always keep video cam-
eras on while conferring with the mediator, 
and no one should record or download any 
record of the mediation. 7

IS VIRTUAL ALWAYS BETTER?
As an attorney who has practiced law since 

1986, I appreciate the convenience of virtual 
hearings, especially with brief, uncontested 
cases. I began my career as a prosecutor, and 
I was in the courtroom daily for motions, 
hearings, and jury trials. I had the benefit of 
knowing, in person, judges, attorneys, and 
court personnel with whom I have formed 
life-long relationships. I also litigated many 
civil cases later in my career, some of which 
were settled when I conferred with oppos-
ing counsel during a break or in the hallway. 
The ability to question and assess a witness, 
to confer with your client, to engage with a 
judge, and to persuade a jury all suffer in a 
virtual setting. While I am not affected be-
cause throughout my career, I have had ex-
pansive and extensive courtroom experience 
in all types of settings, from criminal jury tri-
als to appellate oral argument, to federal court 
and bankruptcy hearings, to civil non-jury 
trials, post-pandemic attorneys, as it now 
stands, likely will miss these very valuable 
experiences. And some think our system of 
justice will suffer due to this lack. 8 

The ability to question 
and assess a witness, 
to confer with your 
client, to engage with a 
judge, and to persuade 
a jury all suffer in a 
virtual setting.
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STAY CONNECTED

Tips for Effectively Communicating with Your Team, 
Clients, and Vendors Remotely
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decades, the methods of communication have 
changed dramatically, but the purpose and 
objectives of how and why humans interact 
have not changed that much. The introduction 
of electronic communication through email, 
texts, instant messaging, and even faxes back 
in the day (if anyone actually remembers them!) 
have made communicating with others easier 
and quicker, which is a true statement. However, 
in many situations, the ease and speed come 
at the cost of truly effective communication 
and includes risks like misunderstanding, 
unintentional sharing, over-sharing, confusion, 
and frustration. 

BY JAN DUKE
CHIEF OPERATING OFFICER
A360INC
JAN.DUKE@A360INC.COM

Over the last several 
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The primary focus when you think about remote 
communication today is on data security and compli-
ant ways to share information. That issue is addressed 
later in the article. I first want to share some tips on 
improving the effectiveness of communication because 
it doesn’t really matter how secure your communication 
is if it doesn’t get the desired result. 

According to a recent Microsoft Insights article that 
cited a McKinsey study, the average professional spends 
28% of their workday reading and answering email. 
That is about 2-3 hours, as a conservative estimate. If 
someone asked you to spend 2-3 hours doing something, 
you would want it to have a purpose or some value. The 
workday shouldn’t be any different. 

Recently, I was on a long flight late in the evening. I 
was feeling lucky as I had gotten a rare first-class up-
grade, so I had extra room to get my laptop out and catch 
up on email. As I started to review my emails from the 
day, I could feel myself getting increasingly frustrat-
ed. There were emails with multiple paragraphs that I 
had to read two and three times to determine if there 

was anything I actually needed to “do” 
with them; there were emails I honest-
ly wasn’t even sure of the purpose; and 
there were emails I didn’t understand 
why I was included in the first place. 
As my frustration grew, my seatmate 
next to me said something that opened 
a conversation between us about corpo-
rate email and the brain drain it causes. 
The flight was heading to San Antonio 
and because it is “Military City USA,” I 
often encounter current or prior mem-
bers of the military, and this particular 
seatmate had retired from the military 
years ago and now worked for a mili-
tary contractor. He shared a concept 
with me which has origins in the mil-
itary but makes so much sense to use 
in all organizations, and I am looking 
forward to making it part of a compa-
ny-wide communication protocol in 
2023. I thought it would be helpful for 
this audience as well.

The concept is called BLUF, which stands for “Bot-
tom Line Up Front,” and I think it makes sense to apply 
to all emails, whether they are to employees, clients, or 
vendors. I have added a few other points to it below 
which can overall improve the effectiveness of email 
communication:

• State the reason for the email clearly and concisely 
in the opening sentence or two (BLUF) so the main 
recipient knows specifically why that email is being 
sent to them

• Followed by the Background (the What/Why) 

• State the Action Needed by the Recipient (what spe-
cifically is needed by whom and by when)

• If others are included only as an FYI, be clear by 
saying: “Jim – this is just an FYI” and include Jim on 
the CC: not the TO: line.
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• Don’t use Email to debate complex topics. If the 
email goes back and forth more than three times, a 
call is necessary. 

• Don’t include people who do not really need  
to be involved. 

Most importantly – make sure your organization under-
stands and follows standard protocol so your clients will 
see your staff’s communication as standing out, saving 
them frustration, bringing clarity, etc. Your employees and 
vendors will also be saved a lot of frustration if everyone is 
trained on the protocol and follows it consistently. 

Of course, it is also critical your communication be 
secure and compliant, so I will close with some top rec-
ommendations on that front: 

1. Ensure your staff is thoroughly trained on what data 
can/cannot be shared and with whom.

2. Utilize a top tier product like MS Office 365 and 

take advantage of their controls regarding encryp-
tion (TLS) and access.

3. Implement strong controls around providing access 
and managing access (internal audits and weekly re-
ports on adds/deletes which are reviewed by some-
one outside of IT).

4. Implement regular entitlement review process (re-
view of specific access rights, not just initial login 
access).

5. Lock down signature blocks so that employees can-
not include phrases or words, or fancy fonts in their 
signature block that are not supported by the com-
pany. Consider a product like Xink.

6. If users are able to access company data (email) on 
a personal device (including cell phone), consider 
using tools like MS InTune to limit what can be 
accessed/shared. 

Source utilized: https://learn.microsoft.com/en-us/viva/insights/manager-insights/overload
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BY SHYLAH MALONEY
ATTORNEY

BARTON GILLMAN LLP
SMALONEY@BGLAW.COM

FINDING STRENGTH  
THROUGH HELPING OTHE RS

WHEN I SAT DOWN to write this piece on what my passion is, it really got me thinking. While many may simply 
speak about their work or hobbies, my passion is about the whole picture. As a fifth-year attorney, I have had the 
fortunate opportunity to try a myriad of different practice areas under the litigation umbrella. Each experience 
brought me closer to finding my true passion, but what I learned is that I knew what my passion was all along. 
Outside of the office, I spend a lot of time with my family and friends and in the community. At the office, I at-
tempt to juggle cases and business relationships with grit and poise. Through it all, the overarching passion that 
I always come back to is helping others. Candidly, I would describe myself as a yes-woman. While this comes 
with some boundary issues (which I am working on, I swear!) it has also allowed me to meet and help so many 
people in my community. I compare the feeling I get from helping others to what many feel while drinking a hot 
cup of coffee: a pure, warm, dopamine rush.
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As a child, the way I would help peo-
ple was through laughter. I did, and still 
do, make it a point to go through situ-
ations with humor (when appropriate). 
It has personally helped me through 
many difficult situations, both as a 
child and as an adult, and I feel oth-
ers can attest that my funny/uplifting 
attitude has helped them during those 
times as well. Then, after college and 
law school, I saw I could help people 
even more through my education. I now 
possessed skills that many need daily. 
In this world, “meeting people where 
they are” is a skill not everyone possess-
es, but my unique experiences in life 

have graced me with this skill, allowing 
me to blend my personality and educa-
tion to help anyone from companies in 
high-value cases to individuals in small 
claims matters. While I am nowhere 
near a miracle worker, I do think I am 
driven by helping others in any way I 
can, through my daily work drafting 
discovery, dispositive motions, argu-
ing at court or in mediation to gain my 
clients the best result; through my vol-
unteerism planning charity events, ral-
lying behind colleagues, providing pro 
bono representation to underrepresent-
ed people; and through my friends and 
family attending their events, support-
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ing them, encouraging them. Each day I 
strive to provide the people around me 
with my best self, and although I may 
fall short from time to time, I wake up 
and try again.

Technology, in many ways, has ex-
panded my reach for helping others. 
During the Covid shutdown, the lo-
cal tenants’ rights group I volunteer 
with was able to switch to remote 
weekly meetings, as well as the Mas-
sachusetts Bar Association’s month-
ly Dial-A-Lawyer program. This has 
allowed me to attend more meetings 
by simply cutting out the travel time 
and help more people. Additionally, I 
have been able to connect with even 
more lawyers, in Massachusetts, but 
also across the nation, on platforms 
like Zoom and LinkedIn. I try to up-
lift other lawyers through support 
on social media, sending a shoutout 
or congratulatory email, or attending 
an event. Moreover, I have used tech-
nology to start my very own podcast, 
Wicked Good Lawyers, which can be 
found on Spotify and Apple beginning 
January 11, 2023. In each episode, I 
have a trailblazer attorney as my spe-
cial guest, discussing their stories, ad-
vice, and the good/bad/funny in the 
legal industry. I thought this would be 
a unique way for others to gain sup-
port, learn about career paths, and 
discuss ongoing trends. 

As you can see, I truly enjoy helping 
others. I do this not for the accolades 
or recognition, but to pay it forward for 
all the people who helped me sit in this 
very seat, in this house my fiancé and I 
bought on our own (the first single-fam-
ily home I have ever lived in!) and typ-
ing this article on a MacBook my family 
could never afford. While I am the one 
who commuted three hours each day to 
go to law school full-time while work-
ing and the one in the summers who 
interned forty hours a week by day and 
worked as a waitress thirty hours a week 
by night, but even then, I did not do it 
on my own. I had cheerleaders, connec-
tions, and family/friends who helped 
my dreams come true. (Many may not 
even know their impact). I find strength 
in witnessing how my various acts of 
kindness/helping others have positively 
impacted their lives. My education and 
personal traits have allowed me to help 
so many people, even early in my ca-
reer, and I will never stop reaching for 
the stars for myself and others. I tru-
ly believe paying it forward is the most 
significant way you can have an impact 
on someone and not even know it. So, 
please take this as a sign to help others 
in any way you can because you never 
know the lasting impact it will have on 
them and you!

All my best from Boston, 
Shylah 

I truly believe paying it forward is the most significant way 
you can have an impact on someone and not even know 
it. So, please take this as a sign to help others in any way 
you can because you never know the lasting impact it will 
have on them and you!
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TikTok
The Next Tech 

Revolution
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BY PAT MANGAN, ATTORNEY, PMANGAN@KLUEVERLAWGROUP.COM AND KATHLEEN KRAMER, 
CHIEF OPERATING OFFICER, KKRAMER@KLUEVERLAWGROUP.COM 
KLUEVER LAW GROUP

T
hroughout our careers, we have all visited Google 
to assist in solving a problem, relied on YouTube 
to learn new Excel tricks or visited Yelp to find a 
restaurant recommendation. When Google was 
founded in 1998, it was inconceivable to main-
stream Americans how useful it would become to 
our everyday life. We no longer say, “go to Google.

com and search for that”; instead, we simply say, “google it”. 
The word “google” became so ubiquitous it was added as a 
verb to the Merriam-Webster’s Collegiate Dictionary in 2006. 
In the 16 years since, we have seen technology flourish. There 
is now an app for everything, a website for even the most ob-
scure hobby, and more influencers than the IRS knows how to 
tax. It can be overwhelming and daunting to both keep up with 
new trends and technologies, let alone determine which ones 
are the most valuable to one’s personal or professional life.

41ALFN WILLed // VOL. 8 ISSUE 1



OUT WITH THE OLD, IN WITH THE NEW
While the advantages of traditional search engines seem innumerable, there is a new kid on the block causing 
everyone to stand up and take notice…TikTok. While once seen as a teenage dance app, TikTok has evolved to 
encompass so much more and is becoming one of the most visited search engines in America. It is a reliable re-
source for anything from recipes to life hacks to real time news stories. As TikTok rapidly gains popularity across 
all generations, the competing tech companies are watching their market share decline at a rapid pace.

TIKTOK BY THE NUMBERS

According to businessofapps.com, TikTok was the most downloaded app in both 2020 and 2021, is the 7th most 
downloaded app of the 2010’s and is the most downloaded application in the third quarter of 20221.

1  Iqbal, M. (2022, November 11). Tiktok revenue and Usage Statistics (2022). Business of Apps. Retrieved December 16, 2022, from https://www.businessofapps.com/data/
tik-tok-statistics/

In terms of monthly active users, TikTok has overtaken 
Twitter, Telegram, Reddit, Pinterest, and Snapchat.

14+ hours
every month on TikTok and 
visit the app an average of 
43.4 times per day.

Users spend an average of

53
of users are between 
19 and 39 years old.

%

138 million
TikTok users are Americans.

1 billion+
videos are watched every 
day in over 35 languages.
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The U.S. Bureau of Labor Statistics re-
ports 35% of the labor force is under the 
age of 402. Compare that to the percentage 
of users in that demographic who use Tik-
Tok (53%), and it should come as no sur-
prise that a significant percentage of your 
employees actively use TikTok. Why does 
this matter? If we lose touch with how our 
employees are accessing information, the 
gap between us will continue to grow, along 
with our ability to effectively connect, train 
and motivate our staff. It is critical that, as 
leaders, we don’t simply invest in improving 
our case management systems but contin-
uously build out our personal technology 
toolbox by being open to exploring new 
apps and search engines.

TIKTOK    – THE 21ST CENTURY 
TRAINER 
T R A I N I N G  T H E  T R A I N E R

On any given day, we juggle meetings, nev-
er ending phone calls, and looming project 
deadlines. Few, if any of us have time to 
master the new technologies our IT depart-
ments are perpetually rolling out. We know 
newer technologies are great and provide 
immense opportunities to become more ef-
ficient; however, the time required to learn 
the new systems are often extensive. This is 
where TikTok has changed the way we learn.

Instead of asking Google how to do some-
thing specific, TikTok allows you to start 
by searching for a topic, such as Microsoft 
Teams. A search on Google will bring up 
several articles on what Microsoft Teams 
is, links to sales websites, and other infor-
mation outside the scope of your purview. 
TikTok, on the other hand, will show you 
videos of helpful tips to make you more ef-
ficient. More importantly, because TikTok 
videos are only 30-90 seconds in length, the 

2  Fry, R. (2020, July 27). Millennials are the largest generation in the U.S. labor force. Pew Research Center. Retrieved December 16, 2022, 
from https://www.pewresearch.org/fact-tank/2018/04/11/millennials-largest-generation-us-labor-force/

content creators are forced to be succinct 
and straight to the point. The more you 
watch a video on a specific topic, the more 
the algorithm learns your interest and gives 
you related content. Before you know it, in 
the 15 minutes it would have taken you to 
comprehend one Google article, you’ve seen 
15 TikToks and learned 15 new tools.

T R A I N I N G  T H E  T E A M

As with anything, information is only use-
ful if it is utilized and shared. While you 
can certainly share a TikTok link with a 
colleague, a great way to showcase the new 
tips and tricks you’ve mastered is by hold-
ing a lunch and learn. In doing so, you’ve 
taken 15 minutes of your time, learned 15 
new useful time saving tools, and can par-
lay that into a team building opportunity. 
Inviting others to share their suggestions 
for things they’ve learned on TikTok has 
the potential to improve morale – your staff 
are talking about things they enjoy which 
are relevant to their life and are discussing 
the technology they are accessing almost 
44 times per day.

However, TikTok is so much more than 
simply a search engine to learn how to use 
shortcuts in Microsoft; TikTok is a phe-
nomenal source of information for other 
areas of leadership – dealing with diffi-
cult employees, management tools, H.R. 
resources, etc. It is also an invaluable re-
source to recommend to employees when 
conducting one on ones – whether they 
are struggling to deploy a project, think of 
creative words to use in reviews, or simply 
find a new recipe for the office potluck.

T H E  S O C I A L  A N D  C A R E E R 

B E N E F I T S  O F  T I K T O K

The benefits of utilizing TikTok as a search 
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engine are not simply limited to technology and 
management. TikTok is a great resource to dis-
cover new restaurants and activities, whether 
you are planning an employee outing or a client 
dinner. When traveling for work, it can often 
be daunting to plan exciting marketing events. 
This is where TikTok really shines by highlight-
ing the venues that are often new to both you 
and your clients. Instead of viewing photos of 
the restaurant from Google maps, on TikTok 
you can see the bartenders mix drinks, get a feel 
for the atmosphere, and see what the food looks 
like in real time.

Finally, TikTok can also help your personal 
career growth by offering concrete ways you can 
ask for a raise, improve your resume, handle a 
difficult conversation or nail an interview. And 
for those who are brave, TikTok might even be a 
way to create your own personal brand or mar-
ket a specific line of business of your company.

Of course, we would be remiss to sing the 
praises of TikTok without also addressing the 
emerging national security concerns. The FBI 
believes the Chinese government can track 
Americans through the app and may potentially 
be able to influence users by censoring certain 
content while simultaneously promoting other 
content.1 In response to this, the U.S. govern-
ment is in discussions with TikTok’s parent 
company, ByteDance, regarding a national se-
curity pact that would alleviate these concerns.

However, in spite of these emerging issues, 
TikTok appears to be here to stay. While it may 
be difficult to imagine a world where TikTok is 
our preferred search engine over Google, there 
was also a time when Blockbuster was in ev-
ery zipcode before they became obsolete with 
the rise of streaming services like Netflix. That 
shift reminds us how imperative it is that we 
as leaders look to the tools of the future, like 
TikTok, to move ourselves, our teams and our 
companies forward. 

1 Treisman, R. (2022, November 17). The FBI alleges TikTok poses na-
tional security concerns. NPR. Retrieved December 19, 2022, from 
https://www.npr.org/2022/11/17/1137155540/fbi-tiktok-national-se-
curity-concerns-china
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Where There’s a
WILL There’s a Word
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BY JEFFREY SCHOENBERGER
SENIOR CONSULTANT
AFFINITY CONSULTING GROUP
JSCHOENBERGER@AFFINITYCONSULTING.COM

While many may use only 20% of Word’s features, it’s not the 
same 20% for everyone. Scientific authors need the ability to 
edit equations. Publishers want pictures, graphics, and lay-
out tools. Legal professionals require automatic numbering, 
cross-referencing, footnotes, and tables of authority.

With that in mind, here are 13 tips to make the most of your 
20% of Word in 2023 or better yet, to expand on it!

1
 

SHORTCUTS:
Word offers tons of shortcut keys for common functions. Un-
surprisingly, the five most popular commands have them: 
Paste (CTRL + V), Save (CTRL + S), Copy (CRTL + C), Undo 
(CRTL +Z), and Bold (CTRL + B). One of my favorites is SHIFT 
+ F3 to change text to all caps. Learn additional keyboard com-
mands for Windows (https://bit.ly/3iDvA8F) and Mac (http://
bit.ly/3uDBXvn).

2
 

QUICK ACCESS TOOLBAR: 
Microsoft introduced the Quick Access Toolbar (QAT) as a 
place to store commonly used commands, accessible irrespec-
tive of which ribbon was active at the time. By default, the QAT 
lives at the top of the Word window (where the document title 
is). But you can move it down below the ribbon for additional 
space. Read Microsoft’s guide for Windows (https://bit.ly/3Bi-
so8X) and Mac (https://bit.ly/3Y7KSmD) on customizing the 
QAT with the commands you use frequently.

I often hear people 
say, “I only use 
20% of Word.” And 
they’re likely correct. 
A report from 2006 
indicated that Word’s 
top five commands 
were, in order: 
Paste, Save, Copy, 
Undo, and Bold, and 
together accounted 
for 32% of all Word 
command usage.
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3
 

DEFAULT FONT: 
On a new installation of Word, the default font is Calibri 11. Unless you change 
that, every time you create a new blank document, you will start with Calibri 11. 
Many law firms prefer Times New Roman, Arial, or something else. Follow the 
instructions Microsoft provides for Windows (http://bit.ly/3VIiZ2M) and Mac 
(https://bit.ly/3UILc8e) users to change the default font. When following those 
instructions, select “All documents based on the Normal template” to ensure the 
new default font applies to all future documents.

4
 

DEFAULT PARAGRAPH:
As with font, Microsoft made default selections for paragraph formatting on 
new Word installations. Microsoft’s default is 1.08 line spacing. Yes, not sin-
gle-spaced, double-spaced, or even 1.5 spacing, but 1.08. Additionally, Micro-
soft adds an extra 8 points (.11”) of space between paragraphs. If you would like 
something different as the default, review Microsoft’s help articles for Windows 
(https://bit.ly/3VIES26) and Mac (http://bit.ly/3HA7s1t).

5
 

UPPERCASE WORDS:
By default, Word ignores all uppercase words when spell-checking a document. 
This can lead to problems for people who title documents with all–caps words. 
You could title a document MOTION FOR SUMARY JUDGMENT and Word 
would never tell you “summary” is misspelled unless you uncheck the option 
to “Ignore words in UPPERCASE.” For Windows, the option is found under File 
> Options > Proofing. For Mac, it’s found under Word menu > Preferences… > 
Spelling & Grammar.

A report from 2006 
indicated that 
Word’s top five 
commands were, in 
order: Paste, Save, 
Copy, Undo, and 
Bold, and together 
accounted for 
32% of all Word 
command usage.
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6
 

MAKE BETTER USE OF AUTOCORRECT: 
Word offers AutoCorrect as a tool to ameliorate typos. If a user types “abbout” or "about,” 
AutoCorrect automatically changes that to “about.” Three AutoCorrect substitutions you may 
want to remove are its automatic replacement of (c) with a copyright symbol, (e) with a euro 
symbol, and (r) with a registered trademark symbol. As a legal writer, you are more likely 
to need to make references to a statute or document provision (c) than to type a copyright 
symbol. You can also use AutoCorrect proactively to replace short phrases with longer ones, 
such as typing “xusb” and having Word automatically replace that with United States Bank-
ruptcy Code. Additional information is available for Windows (https://bit.ly/3Y3HlWa) and 
Mac (https://bit.ly/3Pba5IB) from the Microsoft website.
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7
 

AUTOFORMAT AS YOU TYPE: 
Word tries to help you write by automatically turning email addresses into clickable links, 
replacing “1st“ with “1st,” or applying bullets or numbering to a list of items. You can control 
when, or whether at all, Word does this. AutoFormat options are available for Windows (un-
der File > Options > Proofing > AutoCorrect Options > AutoFormat As You Type) and Mac 
(under Word menu > Preferences… > AutoCorrect > AutoFormat As You Type). Microsoft 
provides details of each option on its website (https://bit.ly/3WgWH8n).

8
 

SELECTING TEXT: 
If you’re editing text in a document and it feels like Word is grabbing more characters than 
you intended, check Word’s options. To regain complete control of your text selection, on 
Windows, go to File menu > Options > Advanced > Editing options and uncheck the follow-
ing: “When selecting, automatically select entire word,” “Use smart paragraph selection,” and 

“Use smart cursoring.” On the Mac, go to Word menu > Preferences… > Edit and uncheck the 
following: “Include paragraph mark when selecting paragraphs,” “Select entire word when 
selecting text,” and “Use smart cursoring.”

ALFN WILLed // VOL. 8 ISSUE 1 49



9
 

DEFAULT PASTE:
If you paste information from non-Word sources, such as a legal research tool, county 
recorder website, or company database, you often bring “extra things” you do not want 
into the document, such as font colors or pictures. To paste from a non-Word program 
into Word without that extraneous material, use the paste option Word calls “Keep 
text only.” To paste into a document keeping only the text, click on the “down arrow” 
portion of the paste button on Word’s Home ribbon. Then select the “Keep Text Only” 
option. A shortcut for this is CTRL + SHIFT+V. You can make the “Keep Text Only” op-
tion the default paste behavior on Word for Windows under the File menu > Options 
> Advanced > Cut, copy, and paste. For “Pasting from other programs,” choose “Keep 
Text Only.” There is no similar setting on Word for Mac, but Microsoft’s forum provides 
a work-around (https://bit.ly/3Fyu7cQ).

10
 

SECTION SYMBOL: 
If you often type section symbols (§) in your documents, you may find it annoying 
to have to go to the Insert ribbon > Symbol > More Symbols > Special Characters tab, 
and then select the section symbol to insert it. To avoid this long series of clicks, once 
you select the section symbol on the Special Characters tab, click “Shortcut Key…” at 
the bottom left and assign a keyboard shortcut to the section symbol. I recommend 
ALT + S, because CTRL + S is taken by “save.” The above steps apply to Word for 
Windows. Word for Mac users have the built-in shortcut of OPT + 6 to generate a § 
symbol wherever they want, in Word or any other application.

11
 

SPLIT VIEW: 
If you frequently work from a single monitor, such as a laptop’s display, then Split View 
can be useful. Activate it from the View ribbon by clicking the Split button. Once ac-
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tivated, Word adds a second horizontal ruler midway down the document. Your document 
has now been split into two views. These two windows move independently. In a pleading, 
for example, you could have the top view on the procedural history or case facts while the 
bottom view is elsewhere in the document, perhaps an argument you are drafting. Split View 
does not create a new document or a copy of your document. It is merely two views into the 
same document, making it easier to navigate, read, and edit larger documents on a single 
screen. To turn Split View off and “collapse the document” back to a single view, click the 
Split button again to disengage Split View.

12
 

NEW WINDOW: 
If you want to accomplish the same document “split” as Split View, but you want to display 
the two windows of the document on two or more full monitors (imagine reviewing title or 
a pleading where you can see and edit the very top and the bottom at the same time), try 
View ribbon > New Window instead. Rather than splitting a single Word document window 
in two, the New Window command creates a second whole Word application window. You 
could place one Word window on each of two monitors. As with Split View, each window is 
a view into the same document. You will be able to tell that you have multiple windows open 
for a single document by looking in the title bar at the document’s name. If you have a single 
window open, the title would be, for example, “Motion for Summary Judgment.” If you have 
two windows open, one would be titled “Motion for Summary Judgment – 1” and the other 
would be titled “Motion for Summary Judgment – 2.” To stop using multiple windows, close 
all but one of the document’s windows. You will notice you won’t be prompted to save until 
you close the last open version of the document. 

13
 

QUICK PARTS:
Quick Parts are similar to AutoCorrect, but much more visual. Additionally, Quick Parts can 
contain font formatting, graphics, and multiple paragraphs of text. Law offices can use Quick 
Parts for common text such as signature blocks or letterheads. Rather than saving different 

“starter” letters for each office or attorney, simply navigate to the Insert ribbon > Quick Parts 
and select the appropriate header. Read more about creating and using Quick Parts in Word 
for Windows (https://bit.ly/3BkxstI). This feature is unavailable in Word for Mac. 

I hope these tips help you start 2023 on good terms with Word. 
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GETTING TO 

Meet Members of the 2022-2023 Amicus
Briefs & Bankruptcy Leadership Teams

KNOW YOU
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GETTING TO 

Meet Members of the 2022-2023 Amicus
Briefs & Bankruptcy Leadership Teams

KNOW YOU

KATHLEEN KRAMER

CHIEF OPERATING OFFICER

KLUEVER LAW GROUP

KKRAMER@KLUEVERLAWGROUP.COM

MICHELE LUBLIN

DIRECTOR OF FINANCE & OPERATIONS

RUBIN LUBLIN, LLC

MLUBLIN@RLSELAW.COM

GETTING TO KNOW YOU is a new series that will introduce members 
of the ALFN community in the hopes of encouraging more meaningful con-
versations and connections throughout the industry. Each WILLed edition 
will highlight new individuals who are a part of ALFN via a “matching” game. 
Anyone who participates will be eligible to win a prize that will be announced 
at the next ALFN conference. Attendance is not necessary to win. Best of 
luck to all players!

Select which “Interesting Fact” you think belongs to which individuals. Vote 
online at https://www.surveymonkey.com/r/PPTNZR7 or scan the QR 
code below.
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AMICUS BRIEFS AND BANKRUPTCY LEADERSHIP

JIM NOONAN
Noonan & Lieberman, LTD.

Chair
Amicus Briefs Committee

A

KERI EBECK
Bernstein-Burkley

Chair
Bankruptcy Committee

B

NICOLE NOEL
Kass Shuler, P.A.
Chair Emeritus

Bankruptcy Committee

C

RESHAUNDRA SUGGS
Miller, George & Suggs, PLLC

Secretary
Bankruptcy Committee

D

NISHA PARIKH
Diaz Anselmo & Associates P.A.
Events, Content & Social Media  

Subcommittee Co-Chair
Bankruptcy Committee

E

OTHER AMICUS BRIEFS COMMITTEE LEADERS
David Rodstein, Vice-Chair; Stephen Hladik, Secretary;  

Andrea Tromberg, ALFN Board Liaison; Rob Edwards, Chair Emeritus 

OTHER BANKRUPTCY COMMITTEE LEADERS
Mike McCormick, Vice-Chair; Chris Carman, Servicer Chair, Jim Timberlake, ALFN Board Liaison; 

Subcommittee Co-Chair; Ryan Starks, Subcommittee Co-Chair
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INTERESTING FACTS
Match each “Interesting Fact” to the individual you believe it represents.

I am the son of Irish 
immigrants, love rap and hip-hop 

music, met Derek Trucks of the Allman 
Brothers, and briefed, argued, and won 

a case in my state’s Supreme Court 
resolving an issue favorable to the 

mortgage industry.

 
After law school graduation and waiting 

for bar results, I spent three months 
for NYC and auditioned for a few 

commercials and magazine shoots – no 
commercial success, however I was 

featured in three magazine campaigns 
and one start up jewelry campaign. It 
wasn’t quite as much fun as I thought 

and definitely reaffirmed my love for law. 
I also love anything sci fi but don’t like 

cheese and chocolate ice cream.

I am certified in Consumer 
Bankruptcy by the American Board of 

Certification. I have four dogs: 2 Golden 
Retrievers, 1 Dachshund and 1 Great 

Dane.I’m the first one from both sides of 
my family to be born in the U.S. After 

undergraduate graduation, I worked as 
a Social Worker for DCFS and then 
as an investigator in custody cases. I 
was planning on getting a Master’s 

Degree in Social Work until a Magistrate 
convinced me to take the LSAT and the 

rest is history!

In my “free time,” I am an 
adjunct professor at two universities 

and one law school teaching Bankruptcy, 
Real Property Finance, and Business 

Litigation.
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The Women of Woods Oviatt's
Default Services Group

Woods Oviatt
Default Services 

Tailoring strategies and
systems to align with your

specific needs.

Our team will help you
navigate through judicial

foreclosures, loss
mitigation, mediations,
litigation, title curative,

bankruptcy, eviction, and
REO matters.

Woods Oviatt Gilman LLP
Full service law firm
focused on building

strategic and long term
partnerships with our

clients. 

We are proud to support ALFN.
www.woodsdefaultservices.com 





NBS IS STILL 
ON THE FIELD 
AND READY 
TO HELP! 

Our areas of expertise include:
Financial Audits • Acquisition Review • Ancillary Services • Transfer of Claim 

Notice of Payment Change • Post-Petition Fee Notices • Proof of Claim Ledger
Proof of Claim Filing • Motions for Relief • Foreclosure Management

Providing staff augmentation services for your bankruptcy and foreclosure departments during the 
disruption. NBS delivers Service with Certainty to banks, credit unions, mortgage servicers and 

investors for their bankruptcy and foreclosure portfolios. That’s a home run!

VISIT US AT NBSDEFAULTSERVICES.COM 

Contact Jim.OReilly@nbsdefaultservices.com

DID RECENT EVENTS 
THROW YOUR 

BUSINESS A CURVE?
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